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April 2016 Update (Build 20.1.789)
Wehave incorporated the following changes in build 20.1.789 for Controlled Release.

Enhancements in this Update
n You can now restore a company from a backup without overwriting the existing company. (Youmight do
this, for example, to review data from backups while leaving your current company intact.)

In Database Administration, on the Restore Company from Backup page, select the backup file you want to
restore, as usual. In theRestore As box, type the new name to give to the restored company, and then
click theRestore Company button.

n In Lookup windows throughout the program, you can now view the names associated with columns that
display certain numbered records, for example, the vendor names for vendor numbers, job names for job
numbers, account names for account numbers, and so on.

n You can now change the size of query windows.

Fixes for Both Editions
n In the 1-5 Bank Reconciliation window, recurring transactions now appear consistently under
Adjustments.

n You can now display all columns in the 5-3-1 Payroll Calculations display lookup window.

n When you email a report usingMicrosoft Outlook, the file name of the attached report now includes the PDF
extension.

n In reports and queries, if you use the “Less” or “Less or =” operator with criteria for date fields (for example,
“Less” and the value “01/01/2015”), the report or query includes records that have empty date values.

n When searching for a record using the F4 lookup key, you can restrict the results to records that contain
specific characters in the description by typing an asterisk (*) at the beginning of the search string. For
example, if you type "*wire" for a part, and then press F4, the resulting list includes all parts that contain
"wire" anywhere in the description.

n In the 9-5 Takeoffswindow, you can now export POs for a job that has a default department, even when
one of the vendors has no default account number, and the previous vendor has a default account that uses
departments.

n In Database Administration, you can now save scheduledmaintenance tasks even if Sage 100 Contractor
is not installed on the server.

n In the 1-7 General Ledger Accountswindow, editing the name of a subaccount no longer updates that
field on all subaccounts that have the same subaccount number.

April 2016 Update (Build 20.1.789)
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March 2016 Update (Build 20.1.780)
Wehave incorporated the following changes in build 20.1.780 for Controlled Release.

Fixes for Both Editions
n Reports that you email using the email icon no longer repeat the PDF extension (for example,
"Report.PDF.PDF").

n Program alerts work as expected when triggered and no longer generate an error message.

n When you include theNotes field in form designs, notes that need to wrap no longer run slightly over the
right side of the page.

n Changingmenu security settings for onemenu no longer affects other menus.

n You are no longer prevented from performing actions that your user groups permit, such as saving records
or changing the posting period.

n In the 1-1 Checks/Bank Chargeswindow, when you save amanual check with a 0 (zero) for the check
number, Sage 100 Contractor continues to run properly, and you no longer receive an error message.

n In the 3-10-2 Compute T&M Invoices, when you use a cost codes pick list to compute invoices, only job
cost records that are allocated to the specified cost code are included in the computation.

n When you post a payroll record that includes overtime pay allocated to a job, the journal entry no longer
distributes some of the employer-paid Social Security or Employment Insurance tax to overhead expense.

Fixes for the U.S. Edition
The following issue was fixed specifically for the U.S. Edition of Sage 100 Contractor:

n When you print certified 5-1-6 Department of Labor reports, you no longer receive an error message
saying that the index was outside the bounds of the array.

March 2016 Update (Build 20.1.780)
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March 2016 Update (Build 20.1.771)
Wehave incorporated the following changes in build 20.1.771 for Controlled Release.

Fixes for Both Editions
n You no longer receive incorrect notifications that scheduled backup was not performed the previous night
when the scheduled backup ran as expected.

n In the 4-7-5 - Reconcile Credit Card Statementswindow, you can now reconcile charges and payments
that were recorded, but not reconciled, in a year that you have archived.

n In the 5-2-1 Employeeswindow, the [Licenses] and [Training] buttons are available, as expected.

n The 9-5 Takeoffswindow now "remembers" changes made to Overhead/Profit rates in a takeoff record the
next time the window is opened.

n If two users enter work orders concurrently in the 11-2 Service Receivables window, the work order
numbers are unique even when job security is turned on.

n The profit (loss) figure reported onBalance Sheet reports is now correct in version 20.1 (matching the
figure in version 19.7), even when you advance the year beforemigrating data from version 19.7.

Fixes for the U.S. Edition
The following issue was fixed specifically for the U.S. Edition of Sage 100 Contractor:

n The 5-1-6-21 Certified Payroll report now reports benefits for the 19-Per Hour (worked hours) calculation
method.

March 2016 Update (Build 20.1.771)
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January 2016 Update (Build 20.1.753)
Wehave incorporated the following changes in build 20.1.753 for Controlled Release.

Enhancements in this Update

Update ACA settings for all employees at once
Sage 100 Contractor provides a very effective way to update ACA settings at the beginning of a new calendar
year or any time you need to change these settings for all employees.

Use the new Update All Employee ACA Settingswindow to update ACA settings in all your employee
records from a single point in the program, rather than changing the settings for each employee individually.

NOTE: When changing ACA settings using this window, you update each setting independently
(except for the 1A Offer of Coverage Codeas noted in step 4).

To change ACA settings for all employees at once:

1. Open the 5-2-1 Employeeswindow.

2. Click Options > Update All Employee ACA Settings.

3. In theUpdate All Employee ACA Settingswindow that opens, specify themonth and the year as of
which the new settings will be effective.

4. Change theExisting value andChange to boxes for the following settings, as needed:

Offer of Coverage Code. You cannot change this code to a blank. If you offered no coverage,
select 1H as the code.

NOTE: If you change theOffer of Coverage Code to 1A, 1F, 1G, 1H, or 1I, the program changes
the Share of Min Plan Premium to zero for all employees that are assigned to this code.

TIP: To clear any existing non-zero premiums youmay have entered for employees assigned to
codes 1A, 1F, 1G, 1H, or 1I, enter the same code in theExisting value andChange to boxes.
For example, if you enter 1A in both boxes, when you click Update, the program clears the Share
of Min Plan Premium for all employees assigned to the 1A Offer of Coverage Code.

Safe Harbor Code.

Share of Min Plan Premium.

NOTE: The Share of Min Plan Premium amount must be zero if the Offer of Coverage Code is
1A, 1F, 1G, 1H, or 1I.

TIP: You can clear all existing premium amounts by entering zero in theChange to box.

5. For each setting you changed, click the [Update] button.

January 2016 Update (Build 20.1.753)
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View current ACA Settings for all employees

To display current ACA settings for all employees:

1. In theUpdate All Employee's ACA Settingswindow, specify anEffective Beginningmonth and
year.

2. Click the [View] button.

The ACA Settings window opens, listing ACA settings for all employees in a grid.

You can use the ACA Settings window to check the existing settings before youmake any changes.

After changing ACA settings, use the ACA Settings window to verify your changes. If you needmake
additional adjustments for an individual employee, select the employee on the grid, and then click the [Drill
Down] button. The employee record opens, where you can change the settings as needed.

Enhancements in this Update
Update ACA settings for all employees at once

Sage 100 Contractor provides a very effective way to update ACA settings at the beginning of a new calendar
year or any time you need to change these settings for all employees.

Use the new Update All Employee ACA Settingswindow to update ACA settings in all your employee
records from a single point in the program, rather than changing the settings for each employee individually.

NOTE: When changing ACA settings using this window, you update each setting independently
(except for the 1A Offer of Coverage Codeas noted in step 4).

To change ACA settings for all employees at once:

1. Open the 5-2-1 Employeeswindow.

2. Click Options > Update All Employee ACA Settings.

3. In theUpdate All Employee ACA Settingswindow that opens, specify themonth and the year as of
which the new settings will be effective.

4. Change theExisting value andChange to boxes for the following settings, as needed:

Offer of Coverage Code. You cannot change this code to a blank. If you offered no coverage,
select 1H as the code.

NOTE: If you change theOffer of Coverage Code to 1A, 1F, 1G, 1H, or 1I, the program changes
the Share of Min Plan Premium to zero for all employees that are assigned to this code.

TIP: To clear any existing non-zero premiums youmay have entered for employees assigned to
codes 1A, 1F, 1G, 1H, or 1I, enter the same code in theExisting value andChange to boxes.
For example, if you enter 1A in both boxes, when you click Update, the program clears the Share
of Min Plan Premium for all employees assigned to the 1A Offer of Coverage Code.

Safe Harbor Code.

Enhancements in this Update
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Share of Min Plan Premium.

NOTE: The Share of Min Plan Premium amount must be zero if the Offer of Coverage Code is
1A, 1F, 1G, 1H, or 1I.

TIP: You can clear all existing premium amounts by entering zero in theChange to box.

5. For each setting you changed, click the [Update] button.

January 2016 Update (Build 20.1.753)
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View current ACA Settings for all employees

To display current ACA settings for all employees:

1. In theUpdate All Employee's ACA Settingswindow, specify anEffective Beginningmonth and
year.

2. Click the [View] button.

The ACA Settings window opens, listing ACA settings for all employees in a grid.

You can use the ACA Settings window to check the existing settings before youmake any changes.

After changing ACA settings, use the ACA Settings window to verify your changes. If you needmake
additional adjustments for an individual employee, select the employee on the grid, and then click the [Drill
Down] button. The employee record opens, where you can change the settings as needed.

Fixes
Wehave fixed the following issues in this product update:

Fixes for Both Editions
n As of build 753, you can control when spell checking for notes occurs. In the 9-5 Takeoffs window, for
example, the Options menu now includes two choices that control when spell checks occur:

p Spell Check on Save. When you select this option, spelling is checked only when you save a note.
Select this option alone if you find that the system is slow when you are typing notes.

p Spell Check while Typing. This option is new. When you select it, spelling is checked continuously as
you are typing. If you find that the system is lagging as you type longer notes, you should clear this
option.

n Before you can print the 1-7-21 General Ledger Account Record, youmust now enter the calendar year
for the report.

n Checks that you edit in the 1-1- Checks and Bank Chargeswindow now appear correctly in the 4-1-5-21
Vendor Payments, 4-1-5-31 Vendor Workers Comp and 4-1-5-61 Vendor 1099 reports.

n Credit card charges are now displayed correctly by transaction and subaccount in the 4-7-5 Reconcile
Credit Card Statementswindow.

n Payroll record reports 5-2-2-26 and 5-2-2-36 no longer repeat the payroll calculation for every time card line
included on the report.

Fixes for the U.S. Edition
The following issue was fixed specifically for the U.S. Edition of Sage 100 Contractor:

Fixes
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n In the 5-3-2 Workers' Compensation window, you can now enter amaximum wage for any state. To set
maximum wage for states other thanOhio, New York, and Nevada, the payroll calculationmust use the 4-
Wages/YearMax Type.

Fixes for the Canadian Edition
The following issues were fixed specifically for the Canadian edition:

n Amounts in boxes 14, 24 and 26 on T4 Slips are now correctly reported for employees who have been paid a
non-taxable per diem.

n In the 4-6 Recurring Payables and the 4-7-3 Enter Credit Card Receiptswindows, if you change the
price of an item while entering a detail line, the program now updates tax amounts accordingly.

January 2016 Update (Build 20.1.753)
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January 2016 Update (Build 20.1.742)
This section describes tax changes included in this January update. It also includes program fixes
implemented since the year-end update released in December 2015.

U.S. Payroll Tax Tables—January 2016 Update
NOTE: Some of these changes were implemented in the year-end update, released in December 2015.
They are shown here for the convenience of customers who skipped that update.

Federal Payroll Tax Changes
The federal government mandated the following payroll tax changes for 2016:

The annual personal exemption increased to $4,050 for 2016.

The PercentageMethod tax tables changed.

Other Government-Mandated Payroll Tax Changes
Payroll tax tables were changed for 2016 for the following jurisdictions:

California

Connecticut

District of Columbia (new in January)

Illinois

Kentucky

Maine

Maryland Local Tax (new in January)

Massachusetts (new in January)

Minnesota

Missouri (new in January)

New Mexico

New York and Yonkers

North Carolina (new in January)

North Dakota (new in January)

Oklahoma

Oregon (new in January)

Rhode Island (new in January)

Vermont (new in January)

January 2016 Update (Build 20.1.742)
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Fixes
Wehave fixed the following issues in this product update:

Fixes for Both Editions
n Lookup screens no longer display encrypted fields.

n Notes that include carriage returns are now formatted properly when you save them, regardless of the spell
check setting.

n An issue in the December year-end release prevented you from completing the payroll archive process.
This issue is now resolved.

Fixes for the Canadian Edition
The following issues were fixed specifically for the Canadian edition:

n In the 4-2 Payable Invoices/Creditswindow, when you change the quantity, price or holdback on any
invoice lines that includeGST, PST, or HST and the invoice has no PO or subcontract, a message asks
whether to recalculate sales tax automatically. If you click Yes, the program calculates tax for the row or
rows.

n Clicking the Contact Us link now displays the contact web page with Canadian English as the default
language.

January 2016 Update (Build 20.1.742)

10 Sage 100 Contractor



December 2015 Year-End Update
This section describes tax changes included in the version 20.1 year-end update, as well as program fixes and
enhancements introduced since build 716, the first build released to all groups participating in the Sage 100
Contractor 2016 Controlled Release.

U.S. Payroll Tax Tables—December 2015 Release

Federal Payroll Tax Changes
The federal government mandated the following payroll tax changes for 2016:

The annual personal exemption increased to $4,050 for 2016.

The PercentageMethod tax tables changed.

Other Government-Mandated Payroll Tax Changes
Payroll tax tables changed for the following jurisdictions:

California

Connecticut

Illinois

Kentucky

Maine

Minnesota

New Mexico

New York and Yonkers

Oklahoma

Rhode Island

December 2015 Year-End Update
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Canadian Payroll Tax Tables—December 2015 Release
This section highlights federal, provincial, andQuebec tax changes.

For more information about these changes, and for information on Employment Insurance, see the Canada
Revenue Agency website.

Federal Payroll Tax Changes
Changes to Canadian payroll taxes include the following :

Income tax thresholds and personal amounts are indexed for 2016.

EI maximum annual insurable earnings and the EI premium rate changed.

CPP maximum pensionable earnings and the basic exemption changed for 2016. Themaximum
contribution amount also changed.

Quebec Payroll Tax Changes
Changes to Quebec payroll taxes for 2016 include the following:

TheQPP maximum contribution amount and contribution rate changed.

Other Provincial and Territorial Payroll Tax Changes
The following provinces and territories mandated payroll tax changes, effective January 1, 2016:

Alberta

British Columbia

New Brunswick

Newfoundland and Labrador

Northwest Territories

Nunavut

Ontario

Saskatchewan

Yukon

For detailed information on personal amounts, see the TD1 form for each province or territory.
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Fixes—Version 20.1 December 2015 Update
Wehave fixed the following issues in the December 2015 product update for Sage 100 Contractor (Controlled
Release) Version 20.1:

Fixes for Both Editions
n You can enter a negative invoice with a use tax in the 4-2 Payable Invoices/Creditswindow. Sage 100
Contractor no longer displays an error message when you click the [Use Tax ] button.

n If you do not use Document Control, Job Document menu items are no longer listed on theProjects tab in
theActivity Centre.

Fixes for the U.S. Edition
The following issues were fixed specifically for the U.S. Edition of Sage 100 Contractor:

n Certified payroll reports now appear only in the 5-1-11 Certified Payroll Formswindow, not in the 5-4-2
State Formswindow.

n In the 5-1-11 Certified Payroll Formswindow, you can now print reports for all jobs marked for certified
reporting that have a status of 3 - Contract or 4 - Current, even if no payroll has been recorded for them.

Fixes for the Canadian Edition
The following issue was fixed specifically for the Canadian edition:

n In the 5-3-1 Payroll Calculationwindow, you can select a Benefit code for union and other reports even if
theCalculation Type is set to 1-Deduct from Employee and the Tax Type is set to 0-None.

Enhancements

General Improvements
This update includes the following enhancements for both the U.S. and Canada editions:

n A new calculationmethod, 19 - Per Hour (worked hours) is available in the 5-3-1 Payroll Calculations
window. Payroll computed for this code (in the 5-2-3 Compute Payroll window) is based on Regular,
Overtime, Premium, and Piece Pay hours.

n The help topic "CalculationMethods, Tax Types, and Calculation Types" has been corrected. It now states
that payroll computed for thePer Hour (all hours) calculationmethod includes all types of hours, both
worked (Regular, Overtime, Premium, and Piece Pay) as well as non-worked hours (Sick, Vacation and
Holiday).

Fixes—Version 20.1 December 2015 Update
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Enhancements for the U.S. Edition
Changes to support federal electronic reporting requirements

New federal regulations in the United States require that you indicate the employee's consent when
transmitting 1094/1095 (B and C) andW-2 forms electronically, and vendor consent when you transmit vendor
1099 forms electronically.

In addition, when submitting 1094-B or 1095-B reports, youmust provide one of the following ACA Policy
Origin Codes:

Unassigned

A - Small Business Options Program

B - Employer-sponsored coverage

C - Government-sponsored program

D - Individual market insurance

E -Multi-employer plan

F - Misc. min. essential coverage

Sage 100 Contractor provides the following new options to help you tomeet these requirements:

To indicate employee consent to transmit W-2 information, you select a new Consent for Electronic
W-2 check box on theCompensation tab in employee records.

To indicate employee consent to transmit ACA information, you select a new Consent for
Electronic ACA check box on theACA tab in employee records.

To indicate vendor consent, you select a new Aatrix Electronic Consent check box and provide a
recipient email address on the Financial Information tab in vendor records.

You select anACA Policy Origin Code for your company using the new option on theGeneral
Information tab of the 7-2 Company Informationwindow.

Your selections for these options are used when you submit Transmittal B forms and consent forms
electronically.

Submitting new consent forms electronically

You use the following new reports in the 5-4-1 Federal Tax Forms and EFiling by Aatrixwindow to send
consent forW-2, 1095 C, and 1099 forms electronically:

2015 1095/1094-C

2015 1095/1094-B

Electronic 1095 Consent

Electronic W2Consent
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You use the new Electronic 1099 Consent report in the 4-5 Vendor 1099 Forms and EFiling by Aatrix
window to send consent for vendor 1099 forms.

Enhanced ACA Reports

Version 19.7 includes a new report, 5-4-3-31 ACA Employee Count Reconciliation, to help you reconcile
your 1094/1095-C ACA forms to your payroll records. This report includes a count of all employees who
worked 130 hours or more eachmonth, including exempt employees.

We have renamed the 5-4-3 ACA Hours Allocation report to 5-4-3-21 ACA Full Time Equivalent Count
report, which reflects the basis of the report and helps to distinguish it from the new report. (This report does
not include exempt employees.)

You can now find both reports under the new menu item 5-4-3 ACA Reports.

Changes for the California Paid Sick Leave Act

As of July 1, 2015, employees working in California for 30 days or more for the same employer are entitled to
receive paid sick leave, accrued at the rate of one hour for every 30 hours worked.

We have updated the following windows and reports in Sage 100 Contractor to accommodate this change for
California and other jurisdictions where you are required to accrue paid sick leave for employees:

5-2-1 Employees. You use the existing Accrued Sick, Accrual Rate, and Accrual Method fields on
the Compensation tab to calculate accrued sick time.

You use two new fields to restrict the sick leave accrual to amaximum amount and to carry forward
the previous year's balance:

In theAccrual Max box, enter themaximum amount of paid sick leave that the employee can
accrue. (This is normally the legal maximum for the state, such as 6 days or 48 hours.)

This maximum is used during the computation of payroll to determine whether sick leavemust be
accrued .

You can change the amount displayed in the Last Year Carry Forward box, if necessary. At the
beginning of a new payroll year, Sage 100 Contractor brings forward the employee's Accrued Sick
balance from the previous year and displays the amount in this box.

This amount is reported on the Sick Leave Verification Report as the accrued sick balance from
the previous year.

5-2-2 Payroll Record and 5-2-3 Compute Payroll. Sick leave accrual is calculated for each payroll
record when payroll is computed.

5-1-8-81 Sick Hours Earned and Used report. This new report shows how many paid sick days
each employee earned and how many they used for each pay period, as required under the new
California legislation. It also shows a running balance for each employee at the end of each pay
period, and includes the amount carried forward from the previous year.

Filter for unneeded payroll calculations in the Aatrix W-2 preparer grid

By default, Sage 100 Contractor sends all payroll calculations to theW-2 preparer grid when you generateW-2
forms. If your company uses a large variety of payroll calculations, it can be very inconvenient to have to

Enhancements
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scroll through columns for calculations that are not required forW-2 preparation.

Now, you can filter unnecessary payroll calculations, so that only calculations required forW-2 forms appear
in the grid. When you turn on this feature, the following payroll calculations are not sent to theW-2 preparer
grid if theW-2 box is blank:

Employer SUI, Liability, or Advance Deduction

EmployerWorkers Comp

Employer SDI

Tax Type 0-None, if one of the following conditions is also true:

Employer Cost and all Subject To boxes are not selected

Deduct from Employee and all Subject To boxes are selected

NOTE: Sage 100 Contractor creates aSkippedPayrollCalcsForW2s.log file in the C:\Program
Data\Sage\Sage 100 Contractor folder that lists all the skipped calculations.

To activate the filter in the W-2 preparer grid:

1. Create a blank text file with the exact nameSkipPayrollCalcsForW2s.config.

2. Save the file to theC:\Program Data\Sage\Sage 100 Contractor folder.
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Enhancements in version 20.1
Sage is excited to introduce Sage 100 Contractor2016 (Version 20.1), which is built on the powerful and
secureMicrosoft SQL Server database platform.

This section describes the new features and enhancements you will find in version 20.1.

New Microsoft SQL Server Platform
Although Sage 100 Contractor 2016 has the same look, feel, and functionality that you are familiar with, its
new SQL database structure affords much tighter security and an up-to-date technology on which to build
future releases. It also provides several other notable enhancements, including:

A new, separate Database Administration tool. You don't have to be an expert user of Microsoft
SQL Server to take advantage of its robust features! We designed Database Administration to
optimize your data for Sage 100 Contractor, for example, by keeping related data in expected
locations and creating backups automatically before performing certain critical processes. Many of
its features are not available through SQL Server Management Studio.

Significantly, Database Administration includes amigration utility that we have designed and tested
extensively to help ensure a smooth and painless transition to SQL Server.

We have relocatedmany administrative utilities and functions from themain Sage 100 Contractor
program to this new tool. However, we have boosted their capabilities considerably, and now provide
easily scheduledmaintenance and backup functions to help you to keep your Sage 100 Contractor
companies in good order.

In addition, Database Administration offers several powerful, new capabilities that enable you to
maintain tight security and exert fine control over user and program access to your SQL Server
instance.

For a comprehensive list of the utilities you will find in Database Administration, see “Database
Administration for Sage 100 Contractor”, later in this document.

NOTE: Database Administration comes with its own help system and a new Database and
Company Administration Guide to acquaint you with its features and to guide you in its use.

Enhancements in version 20.1
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New views for creating reports with third-party report writers. Because the new views point to
the database tables, rather than pointing your reports directly to the tables, we encourage you to use
them when creating custom reports using third-party tools, such as Crystal Reports.

For example, in earlier versions, you would point directly to actpay.vndnme to include Accounts
Payable vendor names in custom reports. In the version 20.1 company database, this information
resides in dbo.actpay.vndnme. However, we recommend that rather than pointing directly to the table
name, you point to the field in the new view: Reports_v1.actpay.vndnme. Report views are located in
the Views folder in your company database.

TIP: A compelling reason to use these views is that they may not be affected by many types of
changes to the underlying tables, so future database changes will not necessarily "break" your
custom reports.

Software and hardware required to support Microsoft SQL Server
Version 20.1 requires an instance of Microsoft SQL Server. You can download and useMicrosoft SQL
Express at no charge, or you can use the full version of Microsoft SQL Server. You can even start using
Microsoft SQL Express, and upgrade to the full version of Microsoft SQL Server later, if necessary.

When you first open the new Database Administration tool, the program tries to configure an instance of
Microsoft SQL Server with optimal settings for Sage 100 Contractor for you. If you do not already have an
instance of Microsoft SQL Server, you can let the Database Administration tool download, install, and
configureMicrosoft SQL Express for you.

Refer to Knowledgebase article 67758 for detailed information about supported operating systems and
software, and for minimum hardware requirements.

Enhancements in version 20.1
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Database Administration for Sage 100 Contractor
The new Database Administration tool is intended for designated system administrators and company
administrators. You use it to set up andmaintain your company databases, and to select advanced settings to
manage communications with and access to your Microsoft SQL Server instance from other programs.

If you have used earlier versions of Sage 100 Contractor, several of these tasks will be familiar to you. For
example, Database Administration includes utilities for creating and deleting a company, backing up and
restoring company files, and archiving company data that you used in previous Sage 100 Contractor versions.

IMPORTANT: Wehighly recommend that you use Database Administration, rather than SQL
Management Studio®, to perform the database administration tasks listed below, even if you are an
experienced SQL Server user. Besides handling all the database tasks that you are likely to perform in a
typical Sage 100 Contractor system, Database Administration was designed to optimize your data for
Sage 100 Contractor, for example, by keeping related data in expected locations and creating backups
automatically before performing certain critical processes. In the rare event that you need to use SQL
Management Studio® to perform a task that is not provided in Database Administration, you should
contact Customer Support for assistance.

Database Administration includes the following database and company management utilities:

Create Company Based on Existing andCreate Company create new Microsoft SQL Server
databases.

Rename Company andDelete Company are convenient utilities when working with existing
companies.

Deploy Sample Company helps you install and refresh the sample data that comes with Sage 100
Contractor.

Tune Up Company Databases performs various maintenance tasks to keep your database
functioning efficiently.

Back Up Company Databases enables you to back up your data "on demand," whenever needed.

Restore Company from Backup restores a backed-up copy of your database.

Upgrade Company Databases prepares your SQL company data so that it is compatible with the
most recent version of Sage 100 Contractor 2016.

Migrate Company Data andMigrate Custom Reports transfers your version 19.7 company data
and custom reports to a new location for Microsoft SQL Server. Migrated files are located in shared
folders under \\ServerName\CompanyName, organized using a folder structure similar to earlier
versions.

Schedule Nightly Maintenance utilities enable you to schedule backup andmaintenance
operations for times when other users are not logged into the system. You can also select the number
of consecutive backups to keep.

Manage Company Admins/SQL Logins utilities enable you to set up or delete logins to the SQL
Server database, and to designate a user as a company administrator for a specified Sage 100
Contractor company.

Database Administration for Sage 100 Contractor
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Advanced Company Settings lets you specify how long to keep history about database changes
for each company, including details about changed records, such as the date and user ID of the
employeemade the change. Details older than the retention period you specify are cleared during
nightly maintenance. (This history is maintained in separate audit tables, which you can query using
SQL Server Management Studio.)

Advanced SQL Server Settings includes convenient, sophisticated access andmemory
management controls for your SQL database.

For detailed information about these utilities and how to use them, see the Database Administration help or
refer to the new Database and Company Administration Guide.

Additional Changes for SQL Server
In addition to the new SQL database platform and the Database Administration tool, you should note the
following important differences from earlier versions:

Because each user must now identify themselves to SQL Server using a unique SQL login, there is
no longer a single Supervisor user. Instead, you designate as Company Administrators users who
require elevated privileges in Sage 100 Contractor.

TIP: You can copy supervisor preferences used in version 19.7 to individual users in the
version 20.1User List window.

When starting Sage 100 Contractor, you first log in to an instance of SQL Server using a new
Connect to SQL Serverwindow, and then you select your company and type of access from the
Company Listwindow.

If you need to change the type of access after logging into the company, you can return to the
Company Listwindow using theChange Company/Access link on the Sage 100 Contractor
desktop.

NOTE: If you want to log in as a different user, youmust close Sage 100 Contractor completely
first, and then log in using a different user name.

You no longer need to reindex your data after upgrading. Now, you use the Database Administration
tool migrate your data from version 19.7 and to update it in future.

Version 20.1 and subsequent releases are installed to a different location than version 19.7 and earlier
versions.

Having separate installation locations enables you to run version 20.1 and version 19.7 on the same
computer while youmigrate your data to the new version.

You need to install the License Administration application and activate the software on the same
computer as your version 19.7 license server, choosing the option to use the computer as the license
server for version 20.1. After installing Sage 100 Contractor on other networked workstations, point to
this machine as the license server.

For more information, see the Installation and License Administration Guide.

Enhancements in version 20.1
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Other Enhancements and Changes

More versatile Lookup windows
In version 20.1, Sage 100 Contractor provides a consistent and versatile set of enhanced Lookup windows
throughout the program

Using the new Lookup windows, you can view information and select records in convenient new ways,
including:

Choose columns to display or hide in a Lookup window.

On theOptionsmenu in any Lookup window, click Select Columns to Show, then select the check
boxes for each column you want to display in the Lookup window, or clear the check box to hide a
column from view.

View the names associated with columns that display certain numbered records, for example, the
vendor names for vendor numbers, job names for job numbers, account names for account numbers,
and so on.

Sage 100 Contractor displays name columns automatically for these numbered records, identifying
them by enclosing the column heading in parentheses, for example "(Vendor Name)."

NOTE: You cannot hide these name columns while the associated number column is
displayed, although you canminimize the columnwidth by dragging the right edge of the column
header. If you hide a number column, the associated name column is also hidden.

Change the order in which columns appear in a Lookup window.

Simply grab the column heading for a column you want to move, then drag it left or right until it is
positioned where you want it to be.

NOTE: If you separate a name column from its associated number column, the Lookup window
does not retain the new position the next time you open the Lookup window. The name column
always appears beside its associated number columnwhen you open any Lookup window.

View more accurate results, and find records more quickly, when you begin typing a search term in a
data control box.

The new Lookup windows display only the records that begin with the characters you type, filtering
evenmore effectively as you continue typing.

When you see the record you want, select it on the list, and then press [Enter] to use it in the
transaction or other window you were working with.

When you close the window, Sage 100 Contractor automatically saves your display preferences, so columns
appear as you want them the next time you use Lookup features in that window.

Unique Payroll record numbers
In version 20.1, after you archive payroll, payroll numbers continue in sequence, rather than starting from 1, as
in previous versions. The advantage is that payroll record numbers are now unique for a company, even
across years.

Other Enhancements and Changes
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Migrating your company data from
version 19.7

IMPORTANT: Youmust be using Sage 100 Contractor version 19.7 tomigrate your company to
version 20.1. If you are using an earlier version of Sage 100 Contractor, youmust first upgrade your
company data to version 19.7.

You use themigration utility in the new Database Administration tool to automatically migrate and upgrade
your data to version 20.1, including all company data in folders and subfolders of …\MB7\[CompanyName].

Migrated files are located in shared folders under \\ServerName\CompanyName. These subfolders are
organized using a similar folder structure as in earlier versions, and include:

Aatrix Forms

Attachments

Direct Deposit

Images

Reports

The Direct Deposit and Reports folders are available as soon as you open the company in Sage 100
Contractor. The remaining folders are created as needed.

NOTE: For detailed, step-by-step instructions onmigration, see theDatabase and Company
Administration Guide or the Database Administration help.

Preparing for migration in version 19.7
Migration should proceed smoothly in most instances. However, you should audit your accounting data and
your company payroll in version 19.7, and then fix any errors, before attemptingmigration to version 20.1.

Use the following audit tools to prepare your data in version 19.7:

1-6 Period and Fiscal Year Management > Audit Books

5-3-7 Payroll Audit

6-6-3 PurchaseOrder Audit

6-7-4 Subcontract Audit

12-5 Inventory Audit

NOTE: If your data includes serious audit errors, youmay need assistance from your business partner
or consultant to prepare your database for migration.

Migrating your company data from version 19.7
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Migrating reports
The new Database Administration tool also includes a utility to migrate and upgrade Sage 100 Contractor
reports and reports written with the Sage 100 Contractor report designer.

In version 20.1, shared custom reports and form designs are located in these folders:

\\ServerName\Sage100Contractor\Custom Reports

\\ServerName\Sage100Contractor\Report Forms

Private custom reports and form designs are located in Sage 100 Contractor User Data folders associated
with each user name, as follows:

\\ServerName\Sage100Contractor\User Data\username\Custom Reports

\\ServerName\Sage100Contractor\User Data\username\Report Forms

Updating custom reports
You also need to update custom reports created with third-party software, such as Crystal Reports, so they
map to the new database.

We recommend that you use the new report views that comewith version 20.1 to create or update reports.
The new views were created for your convenience, so that future database changes will not necessarily break
your custom reports.

After migrating your company data
After migrating your data, you will likely need to perform the following additional steps to prepare your
company for use in Sage 100 Contractor:

IMPORTANT: UseDatabase Administration, not SQL Server Management Studio, for all these tasks.

Add company administrators. There is no longer a generic "supervisor" user as there was in earlier
versions. All users must sign into the company using their personal IDs, and only users designated
as company administrators have heightened privileges previously associated with the "supervisor"
role. You can designate one user as a company administrator duringmigration, but you can add
others later.

Add SQL logins for new users. If you have new users that did not exist in your version 19.7
company, add them as users to the SQL database.

Youmust also add them as users and assign security in Sage 100 Contractor.

Migrating reports
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Designate an additional SQL Server administrator. Only a user with system administrator
privileges for the SQL instance can administer users for SQL Server or assign the system
administrator role to another user. Therefore, it is vital at all times that more than one user has a
system administrator role. If the principal system administrator should suddenly fall ill, or leave your
company, or otherwise be unable to perform their duties, another person with administrative access
to the SQL Server databasemust be able to take over that role.

NOTE: The person who installs Sage 100 Contractor is automatically assigned a 'sysadmin'
role in SQL Server. When they designate a SQL Server administrator in Database
Administration, that person is also assigned the 'sysadmin' role in SQL Server.

Switch your Sage Construction Anywhere to version 20.1. If you have been using Sage
Construction Anywhere with Sage 100 Contractor version 19.7 and want to use it with version 20.1,
you will need to switch the connection to version 20.1. For help on switching the connection, see the
instructions in the Installation and License Administration Guide.

Migrate your Sage ACT! settings to version 20.1. If you have been using Sage ACT! with Sage
100 Contractor version 19.7 and want to use it with version 20.1, you need to change your ACT!
settings to point to your new version 20.1 company database. For help onmigrating your ACT!
settings to version 20.1, see the instructions in the Installation and License Administration Guide.

Migrate each user's scheduled reports from version 19.7. See the instructions in the Installation
and License Administration Guide.

Migrate each user's alerts from version 19.7. See the instructions in the Installation and License
Administration Guide.

Changes to converted data
Duringmigration, the programmay encounter problems that might prevent it from writing a particular record to
the new SQLServer database.

If the problem is one that themigration program can fix, it repairs the record, and then writes the updated
record to the SQL Server database. (For a list of the types of errors that can be fixed duringmigration, see the
Database and Company Administration Guide.)

NOTE: Not all errors can be fixed duringmigration. In these cases, the record is not written to the new
database.

The migration log file
The program keeps a log of all changed records and records that were not migrated because of an
unresolvable error, unless the record was invalid in version 19.7. (Invalid records are neither migrated nor
logged.)

After migration, you should check the log file to see what changes weremade to your data during conversion,
or whether any records were not migrated to the new SQL database.

Migrating your company data from version 19.7
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The _SQL_MIGRATION_LOG.TXT file is located in the source company's main folder (for example,
C:\MB7\Sample Company). A supplemental file, _SQL_MIGRATION_LOG_VERBOSE.TXT, includes more
detailed information about each error found.

Changes to converted data
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Known Issues and Comments
The following sections describe known issues and problems in Sage 100 Contractor Version 20.1.

General

Internet access required for Sage 100 Contractor
Sage 100 Contractor features, such as printing or efiling tax forms, submitting enhancement requests,
accessing Help, or downloading periodic product or tax updates all require Internet access.

To take advantage of these features, ensure that any workstation or server that Sage 100 Contractor is
installed on has access to the Internet.

During installation of Sage 100 Contractor, the computer serving as the Sage license server must be able to
connect to the Internet to obtain licenses. Once installation is complete, you can check out license uses for
each computer where Sage 100 Contractor is installed, then disconnect the Sage license server from the
Internet.

NOTE: A static Internet connection using a compatible web browser is required for Sage Construction
Anywhere. For current information on supported browsers, supported Sage 100 Contractor versions, and
other system requirements, see the Sage Construction Anywhere help at
http://help.sageconstructionanywhere.com/sage100contractor/help/Default.htm#01_Setup/System_
requirements.htm.

Sage Advisor Update
Sage Advisor Update is a notification and download service that alerts you when an update is available for
Sage 100 Contractor. You can use Sage Advisor Update to download and install updates available for Sage
100 Contractor and other Sage products for which you have a current Sage Business Care Plan.

TIP: Use theCustomize settings in theWindows system tray tomake sure you can view the Sage
Advisor Update icon and notifications from the System Tray in your Taskbar.

For more information about Sage Advisor Update, see "About Sage Advisor Update" in the User Guide and in
the Sage 100 Contractor help.

Tax Forms and eFiling by Aatrix configuration requirements
Tax Forms and eFiling by Aatrix requires an Internet connection for two reasons:

For updating forms and executable files.

For electronic filing (eFiling) of the forms.
If you experience an Internet connection problem, it may be due to problems communicating through an
Internet firewall. Firewalls need to have access allowed through specific ports:

The Tax Forms and eFiling Updater uses standard SSL/HTTP port 80 to access the site
http://updates.aatrix.com.

Known Issues and Comments
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The eFiling component uses secure HTTPS on port 443 to access the site https://efile.aatrix.com.
By allowing access to aatrix.com, you allow both updates and eFiling. Occasionally, restrictions are tighter
and only allow access to these ports by specific programs. Tax Forms and eFiling uses the following
programs to access the Internet.

For updating using http on port 80 to http://updates.aatrix.com:

aatrixforms.exe

updater.exe

updater2.exe
For eFiling using secure http on port 443 to https://efile.aatrix.com:

builder.exe

viewer.exe

Printing reports at year-end (U.S. Edition)
As of Version 19.2, in the U.S. Edition, if you pay retainage in the current year for a prior year invoice and then
you print a 4 1 3 26 AP Aging report for the prior year, the report shows a reduced retainage amount, and the
amount paid in the future period is allocated to the Current period or an aging period, depending on the due date
of the retainage and the date it was paid.

Therefore, you should print these reports as part of your year-end processing to ensure that you have a set of
reports that reflect the true amount of retainage outstanding at year end.

TIP: If you archive your data at year end, you can also print the reports from the archive company, later.

PCI DSS Compliance
PCI DSS stands for Payment Card Industry Data Security Standard. It was developed by themajor credit
card companies as a guideline to help organizations that process card payments to prevent credit card fraud,
cracking, and other security weaknesses and threats.

A company processing, storing, or transmitting payment card datamust be PCI-compliant or risk losing its
ability to process credit card payments and being audited and/or fined. (For more information about PCI
standards, see https://www.pcisecuritystandards.org/.)

Sage 100 Contractor payment processing works exclusively with Sage Payment Solutions to enable
merchants to seamlessly process check and credit card transactions directly in Sage 100 Contractor. The
payment processing program uses Sage Exchange, a secure payment-processing application, to connect to
Sage Payment Solutions and process check and credit card transactions.

Integrating your financial and operations system with Sage Payment Solutions lets you process check and
credit card transactions without storing your customers’ sensitive card information in your database. Sage
Exchange transmits check and credit card details through a secure connection to Sage Payment Solutions,
where they are stored in a PCI-compliant vault, protecting your from exposure to non-compliance penalties
and credit card fraud.

General
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CAUTION: To avoid non-compliance with PCI standards, do not store credit card information in Sage
100 Contractor. Such storage creates unnecessary risk for your business and your customers.

Use Adobe Reader Version 8.1.3 or later for faxing
Customers have reported problems faxing from Sage 100 Contractor with versions of Adobe Reader earlier
than 8.1.3. Adobe Reader Version 8.1.3 and later support faxing fromWindows and from Sage 100
Contractor.

IMPORTANT: To fax from Sage 100 Contractor, theWindows Fax Service component must be
installed with yourWindows operating system. For more information about installing theWindows Fax
Service component, see the Sage 100 Contractor Help topic, “Installing theWindows Fax Service
component.”

Printing reports to PDF or exporting to Excel?
When you print reports to PDF, youmay find that the size of the PDF file is unexpectedly large and the
resolution of the displayed PDF is not optimal.

To create a substantially smaller PDF file with good resolution, you can run Sage 100 Contractor in
Compatibility Mode (compatible withWindows 7), and then print the report.

NOTE: You cannot export to Microsoft Excel when running Sage 100 Contractor in Compatibility Mode
if you useMicrosoft Office 2013.

We have not encountered this issue during testing, nor has it been reported forWindows Server 2012 R2.

About network configuration and TCP Remoting Channel
Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component, to enable
communication among computers on a network. By default, Sage 100 Contractor uses the TCP starting port
48750. Certain configurations can potentially disable the communication:

File sharing on computers running theWindows 8.1, Windows 7, Server 2008, Server 2008 R2, and
Server 2012 operating systemmust be enabled. To enable file sharing, follow the instructions in the
Windows Help.

TCP communication requires the selection of port numbers that are not in use by other processes on
the local computer.

Software firewalls running on the local computer can be configured to block processes from opening
TCP ports, which will prevent communication through the TCP Remoting Channel.

Known Issues and Comments
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Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-
start on Windows 8.1, Windows 7 Professional, Server 2008, or Server
2008 R2 Standard
The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers
running theWindows 8.1, Windows 7 Professional, Server 2008, or Server 2008 R2 Standard operating
systems. If the service stops, the program displays amessage advising you to take further action to resolve
this issue.

Configuring anti-virus software and third-party firewalls
During installation of the Sage 100 Contractor Hosting Framework, theWindows Firewall is configured
automatically to allow the Sage 100 Contractor Hosting Framework to act as a TCP server. If you use some
other firewall, however, youmay need tomanually adjust some settings in the firewall in order to ensure
proper operation.

You can use the following basic procedure tomanually configure theWindows Firewall to allow the Sage 100
Contractor Hosting Framework to communicate with other computers. Use it as the basis for manually
configuring other third-party firewall products.

To configure the Windows Firewall:

1. ForWindows Server 2008, click Start > Control Panel > Security.

ForWindows 7, click Start > Control Panel > System and Security

ForWindows 8.1, click Start > All apps > Control Panel > System and Security.

2. OpenWindows Firewall, and then select Allow a program or feature through Windows Firewall.

3. If Sage 100 Contractor Hosting Framework is not on the list, you can add it by selectingAllow another
program, then browsing to the following path:
\MB7\Programs\Sage.CRE.HostingFramework.Service-InstanceConfig.xml.

NOTE: By default, the exception is set to allow access by any computer on the network. You can refine
this setting by selecting theChange Scope button. Be aware that restricting the scope incorrectly can
cause the computer to be unable to connect with some or all of the other machines on the network.

Files to exclude when manually configuring your firewall for Windows 8.1 Professional
32-bit

C:\ProgramData\Sage\Sage 100 Contractor

C:\Program Files\Sage\Sage 100 Contractor

C:\ProgramData\Aatrix Software

C:\Program Files\Aatrix Software

C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database
Administration, this location is C:\Sage100Con\Company\.)

General
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Files to exclude when manually configuring your firewall for Windows 8.1 Professional
64-bit

C:\ProgramData\Sage\Sage 100 Contractor

C:\Program Files (x86)\Sage\Sage 100 Contractor

C:\Program Files (x86)\Aatrix Software

C:\ProgramData\Aatrix Software

C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database
Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 7 Professional
32-bit

C:\ProgramData\Sage\Sage 100 Contractor

C:\Program Files\Sage\Sage 100 Contractor

C:\ProgramData\Aatrix Software

C:\Program Files\Aatrix Software

C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database
Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 7 Professional
64-bit

C:\ProgramData\Sage\Sage 100 Contractor

C:\Program Files (x86)\Sage\Sage 100 Contractor

C:\Program Files (x86)\Aatrix Software

C:\ProgramData\Aatrix Software

C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database
Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 8.1 Professional
C:\ProgramData\Sage\Sage 100 Contractor

C:\Program Files (x86)\Sage\Sage 100 Contractor

C:\Program Files (x86)\Aatrix Software

C:\ProgramData\Aatrix Software

C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database
Administration, this location is C:\Sage100Con\Company\.)

Known Issues and Comments
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Files to exclude when manually configuring your firewall for Windows Server 2008, 2011,
2012

C:\ProgramData\Sage\Sage 100 Contractor

C:\ProgramFiles (x86)\Sage\Sage 100 Contractor

C:\Program Files (x86)\Aatrix Software

C:\ProgramData\Aatrix Software

C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database
Administration, this location is C:\Sage100Con\Company\.)

Configuring Windows Regional and Short Date Format
To specify regional formats for Windows:

1. Click the [Start] button, point toControl Panel, then click Clock, Language, and Region .

2. Click Region and Language.

3. On the Formats tab, select the format for your country.

4. UnderDate and time formats, from the Short date format drop-down list, select the format used for
your country.

5. Click [OK].

6. Close theClock, Language, and Regionwindow.

Posting Status for a Company Created since Version 19.2
If you created a new company using version 19.2, or higher, in certain limited scenarios an issue can arise
after you advance the year to the first period of the new fiscal year. The new year may not be available when
you try to change the posting period.

A fix to prevent this issue is included in the January 2015 update. However, if you have already encountered
this issue, contact Customer Support for assistance.

Windows 8.1 Professional and Server 2012 Standard
Operating Systems

Windows 8.1 Professional and Server 2012 Standard "Sleep Mode"
prevents computers from obtaining a license use
If a computer running theWindows 8.1 Professional or Server 2012 Standard operating system is used as a
license server, when it goes into sleepmode other computers on the network can’t obtain a license.

To avoid this possibility, set Sleep Mode on your license server computer toNever.

Windows 8.1 Professional and Server 2012 Standard Operating Systems
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To set the Sleep Mode to “Never”:

1. Start > All apps > Control Panel > System and Security > Power Options.

2. Select Change when computer sleeps.

3. From thePut computer to sleep list, select Never.

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-
start on Windows 8.1
The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers
running theWindows 8.1 Professional orWindows 8.1 Enterprise operating systems. If the service stops, the
program displays amessage advising you to take further action to resolve this issue.

Solution for Server 2012 error message about mb7.kpr file
If you encounter an error message about opening themb7.kpr file when launching Sage 100 Contractor on a
computer runningWindows Server 2012, follow these steps to resolve the issue:

1. On theWindow desktop, right-click Start, and then click Explore.

2. On the left side of the window, under Folders, right-click theMB7 folder, and then select Properties.

3. On theMB7 Propertieswindow, click theSecurity tab.

4. From the list underGroup or User Names, select USERS, and then click [Edit].

5. On thePermissionswindow, select USERS again, and underAllow, select the Full control check
box.

(Selecting Full control selects all the check boxes necessary for this solution.)

6. On thePermissionswindow, click [OK].

7. On theMB7 Propertieswindow, click [OK].

Server 2012 network configuration and TCP Remoting Channel
Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable
communication among computers on a network. File and printer sharing on computers running the Server
2012 operating systemmust be enabled. To enable file sharing, follow the instructions in theWindows Server
2012 Help.

Known Issues and Comments
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Windows 7 Professional and Server 2008 R2 Standard
Operating Systems

Launching Sage 100 Contractor to run as administrator for scheduling
reports

IMPORTANT: On computers runningWindows 7 Professional or Server 2008 R2 Standard, scheduling
Sage 100 Contractor reports requires that you “run as administrator” or to “run the program as
administrator.”

Microsoft Windows changed security rules in theWindows 7 Professional and Server 2008 R2 Standard
operating systems tomake your computer more secure. If you are running Sage 100 Contractor as a typical
user, then you have limited privileges in some areas of the program, such as saving a report schedule. To
save a report schedule, youmust launch Sage 100 Contractor with the command to eitherRun as
administrator orRun this program as an administrator.

When you select either command, the settings are limited to you personally. Your settings to run Sage 100
Contractor as administrator do not affect the next person who logs on and launches Sage 100 Contractor from
this computer. Your settings on this computer can either be temporary or persistent. For example, when you
select Run as administrator, you run the program as administrator for that session only. When you select Run
this program as an administrator, you set program properties to always run the program as administrator
when you log on to this computer.

NOTE: "Run as administrator" and "Run this program as an administrator" are not related to
Windows 7 Professional or Server 2008 R2 Standard operating systems user groups but are limited to a
specific program you are running.

To set "Run as administrator":

1. On yourWindows desktop, right-click the Sage 100 Contractor program icon.

2. From the drop-downmenu, to launch the program, click Run as administrator.

NOTE: SelectingRun as administrator only runs the current session of running Sage 100 Contractor.
The setting does not persist after the session is over.

To set "Run this program as an administrator":

1. On yourWindows desktop, right-click the Sage 100 Contractor program icon.

2. From the drop-downmenu, click Properties.

3. On the Sage 100 Contractor Properties window, click theCompatibility tab.

4. Under Privileges Level, select Run this program as an administrator.

5. Click [Apply], and then click [OK].

NOTE: SelectingRun this program as an administrator always runs the program with these
properties when you launch the program on this computer. The setting persists.

Windows 7 Professional and Server 2008 R2 Standard Operating Systems
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Windows 7 Professional, Windows 8.1 Professional, and Server 2008 R2
Standard "Sleep Mode" prevents computers from obtaining a license use
If a computer running theWindows 7 Professional, Windows 8.1, or Server 2008 R2 Standard operating
system is used as a license server, when it goes into sleepmode, other computers on the network can’t
obtain a license.

Set Sleep Mode on your license server computer toNever.

To set the Sleep Mode to “Never”:

1. Start > Control Panel > System and Security > Power Options.

2. Select Change when computer sleeps.

3. From thePut computer to sleep list, select Never.

Windows Server 2008 R2 and Microsoft .NET 3.5.1
Microsoft .NET 3.5.1 must be available and enabled prior to installing Sage 100 Contractor on aWindows
Server 2008 R2machine. Server 2008 R2 comes with .NET 3.5.1 loaded but not installed, so Sage 100
Contractor doesn’t install it automatically.

If you attempt to install Sage 100 Contractor without .NET 3.5.1 installed, you will receive the following
message during the licensing install: “Sage.CRE.HostingFramework.Service v3.2 has stopped working.”
When you click [OK], the installation continues, but the services have not been installed so Sage 100
Contractor cannot open. The Sage.CRE.HostingFramework Service will not install unless .NET 3.5.1 has
been installed. If you receive the abovemessage during installation, install .NET Framework 3.5.1 and
reinstall Sage 100 Contractor.

To verify that .NET 3.5.1 is installed on Windows Server 2008 R2:

1. Click theStart button in the lower left corner of the display.

2. Highlight Administrative Tools and select Server Manager.

3. In theServer Manager interface, click Features to display all the installed Features in the right-hand
pane. Verify that .NET Framework 3.5.1 is listed.

To enable .NET 3.5.1 on Windows Server 2008 R2:

1. In theServer Manager interface, select Add Features to display a list of possible features.

2. In theSelect Features interface, expand .NET Framework 3.5.1 Features.

3. Once you expand .NET Framework 3.5.1 Features, you will see two check boxes. Check the box next
to .NET Framework 3.5.1 and click Next.

4. In theConfirm Installation Selections interface, review the selections and then click [Install].

5. Allow the installation process to complete and then click [Close].

NOTE: Enabling .NET Framework 3.5.1may require a reboot.
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Solution for Server 2008 R2 "Permission Error Opening File"
If you see a permission error message when launching Sage 100 Contractor on a computer running the
Windows Server 2008 R2 operating system, follow these instructions:

1. On theWindow desktop, right-click Start, and then click Open Windows Explorer.

2. On the left side of the window, underComputer > Local Disk, right-click the \MB7 folder, and then
select Properties.

3. On theMB7 Propertieswindow, click theSecurity tab.

4. From the list underGroup or User Names, select USERS, and then click theEdit button.

5. On thePermissionswindow, select USERS again, and underAllow, select the Full control check
box.

Selecting Full control selects all the check boxes necessary for this solution.

6. On thePermissionswindow, click [OK].

7. On theMB7 Propertieswindow, click [OK].

Solution for Windows 2008 Server R2 Application Error Message
Under some circumstances, on servers operatingWindows 2008 Server R2, youmay see the following error
message when trying to open a photograph or image file in Sage 100 Contractor:

"No application is associated with the specific file associated with this application."

This error message appears when you attempt to open an image file in Sage 100 Contractor but you have not
yet enabled the Desktop Experience feature inWindows 2008 Server R2. If you receive this error message,
install Desktop Experience using the Server Manager utility:

1. InWindows 2008 Server R2, select Start > All Programs > Administrative Tools > Server
Manager.

2. In theServer Managerwindow, click Features (left-hand pane).

3. In the Features pane, click Add Features.

4. Select the Desktop Experience check box.

5. If you are prompted to add additional features, click [Add Required Features].

6. Click [Next].

7. Click [Install].

Windows 7 and Server 2008 Operating Systems

Solution for Server 2008 "Permission Error Opening File"
If you see a permission error message when launching Sage 100 Contractor on a computer running the
Windows Server 2008 operating system, follow these instructions:

Windows 7 and Server 2008Operating Systems
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1. On theWindow desktop, right-click Start, and then click [Explore].

2. On the left side of the window, under Folders, right-click the \MB7 folder, and then select Properties.

3. On theMB7 Propertieswindow, click theSecurity tab.

4. From the list underGroup or User Names, select USERS, then click the [Edit] button.

5. On thePermissionswindow, select USERS again, and underAllow, select the Full control check
box. Selecting Full control selects all the check boxes necessary for this solution.

6. On thePermissionswindow, click [OK], and then on theMB7 Propertieswindow, click [OK].

Server 2008 “Sleep Mode” prevents computers from obtaining a license
use
If you are using a Server 2008 computer as the Sage license server and it goes intoSleep Mode, the
workstations cannot obtain a license use.

Use a different computer on your network to be the Sage license server. Any supported operating system can
be used in place of Server 2008.

Set Sleep Mode on your license server computer toNever.

To set the Sleep Mode to "Never":

1. Start > Control Panel > System and Maintenance > Power Options.

2. Select Change when computer sleeps.

3. From thePut computer to sleep list, select Never.

Windows 7 and Server 2008 and changing the Sage License Server
computer
On aWindows 7 or Server 2008 workstation, when you select File > Change Sage License Server >
Select the computer from the list of computers on your network, the commandmay fail to generate a list
of network computer names.

To resolve this issue, click Enter the IP address or name of the computer, and then type the IP address of
the server computer in the box.
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